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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

Scroll Arrow Disappeared in Internet Explorer; Tune up My Old Tired Computer; Cutting Down on
Spam—for Now.

Scroll Arrow Disappeared in Internet Explorer
Dear Digital Dave,

I'm using my HP laptop with Windows 7 and Internet Explorer, but when I have an open
Web page, after about two or three seconds my scroll arrow that I use to move my pages up
or down disappears until I move my mouse again then it reappears. Not only that, but while
using the scroll feature (I have a touchpad) when scrolling a bit at a time, the mouse
position will automatically move up a little, causing the page to very quickly jump way up
the page. Very frustrating! I have run my antivirus and spyware software, run my hard drive
"cleaner" even my registry cleaner, but that doesn't help. Any help is much appreciated.
Jerry Hughes
San Diego, CA

Dear Jerry,

I don't think that your problem is caused by a virus. Malware is unlikely to attack the scroll
bars in Internet Explorer. While I couldn't find any specific resolution (nor reproduce the
effects on any of the versions of Internet Explorer that I have), I do have a couple of
suggestions.

First, make sure that you have the latest update for the Internet Explorer (IE) version that
you're using. If you're running IE 11 on a Windows 7 computer, then you might try rolling
back to IE 10. IE 11 has been problematic with Windows 7.

Second, an alternative way to scroll Web pages is with the UP and DOWN arrow keys. You
may find these easier, especially if you're using a touchpad which can be a little tricky. This
may also resolve the problem with the jumping cursor.

The problem with many touchpads is that the scroll portion of the pad is so close to the regular
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mousing area that it's easy to accidentally touch the wrong part of the pad while scrolling. This
can cause the cursor to jump, especially if you have fat fingers. Using the UP and DOWN
cursor arrow keys will eliminate this inadvertent touching.

The final recommendation is to switch to Google Chrome, Mozilla Firefox or Opera. They are
all free and unlikely to have the same problems as Internet Explorer.

Digital Dave

Tune up My Old Tired Computer
Dear Digital Dave,

I keep getting adverts from AOL for a program that will "Tune up my old tired computer," or
some such miracle. Are any of these programs worthwhile? Do you suggest any particular
program?

Thanks,
Wayne Gilbert
Westminster, CO

Dear Wayne,

While it's possible that some of these programs are useful, they are rarely worth the price that
they charge. Whatever they do you can do yourself better—and without paying anything.

One of the most common issues that will cause a computer to slow down is fragmentation of
the hard drive. This occurs over time as saved files are broken into pieces to take advantage of
available space. In Windows Vista and above, by default defragmentation is automatically
scheduled once a week so there is no need to worry about it unless you either disabled the
regular schedule or the drive became so full that it could no longer complete a
defragmentation. (There must be enough space on the drive to copy and move the files one at
a time.)

If you're using Windows XP then you will want to periodically defragment your drives. It is
not automatic. Open Windows Explorer, right-click on the target drive, select Properties, then
the Tools tab. Click Defragment Now, then click Defragment. Once the process is started, do
not interrupt it. If it's been some time since the last defragmenting, it may take a while.

Note: Solid State Drives (SSD) do not require defragmentation since they have no moving
parts to slow things down. In fact, regular defragmentation of a SSD can shorten its life. If you
use a SSD, turn off the automatic feature in Windows Vista and above.

April 4, 2014 Tune up My Old Tired Computer

7

http://www.google.com/intl/en/chrome/browser/
http://www.mozilla.org/en-US/firefox/new/
http://www.opera.com/


Another source of possible slowdown problems is the accumulation of unnecessary temporary
and cached files that get sifted through during certain operations. Many people don't realize it,
but Windows comes with a cleanup program called Disk Cleanup. It can be launched from the
General tab of the disk Properties window; search for the term "cleanup" in the Start menu
and select Disk Cleanup; Run ( +R), type cleanmgr, and then click OK; or Start => All
Programs => Accessories => System Tools => Disk Cleanup. The process starts with a scan
of the drive (See Figure 1.)

Figure 1. Windows Disk Cleanup starts by scanning the selected drive.

Once the drive scan is completed, a list of possible files to delete pops up. (See Figure 2.)
Check those files which make the most sense.
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Figure 2. Check the files that you want deleted.

The number of files removed by Windows Disk Cleanup is limited when compared to a
program such as the free version CCleaner which also deals with the temporary and cached
files of specific programs such as Web browsers. I've found CCleaner to be effective at
removing files which clog the system.

I don't necessarily recommend Registry cleaners (even the one in CCleaner). First, even if
there are unneeded entries in the Windows Registry, they are unlikely to cause any slowing
down. Second, the problem with Registry cleaners is that they may actually remove something
your system or one of the installed programs needs. I've seen times where a Registry backup
needed to be restored because a supposed cleaning took out too much thereby disabling a
program.

While many of them may be adequate, some of the advertised PC tuneup programs are out
and out scams just looking to pry a little money out of you. They work no better than using
your own freely available cleanup software and antivirus programs.

Digital Dave

Cutting Down on Spam--for Now
If you get a lot of Spam you may have noticed that lately quite a bit of it comes from Europe
with the domain EU. It is a fairly new domain and has become the go-to address for
Spammers who normally avoid blocking by regularly changing addresses. One reason that
Spammer may be using EU is because it doesn't appear in the Junk E-mail Options under the
International tab when "Blocked Top-Level Domain List…" is clicked (see Figure 3).
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Figure 3. The domain EU is not an option in Windows Mail for blocking as a Spam domain.

Not having this missing option is pretty frustrating once it sets in that 90% of today's Spam is
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coming from .eu addresses. However, there is a way to block the domain with very little risk.

First, if you happen to know anyone with an EU e-mail address, tell them to get rid of it. It has
become too tarnished through Spamming to ever be redeemed. The steps you're now going to
take will prevent any EU e-mail from getting through.

Open up the window that allows you to make a Message Rule. In Windows Mail use the Tools
=> Message Rules => Mail… menu options. Add "Where the From line contains '.eu' as a rule
that moves the e-mail to the Junk E-mail folder (see Figure 4).

Figure 4. Create a Message Rule which moves any e-mail that includes ".eu" in the address to the Junk Mail folder.

Now, all the EU e-mail will be appropriately dispositioned. The only problem with this
approach is that any From line which includes ".eunice" or ".eulogy" will also be sent to the
Junk E-mail folder. So tell Eunice to change her e-mail address.

If enough people do this, then the Spammers will eventually give up on EU. I hope this doesn't
happen too soon because then I'll need to find another way to block most of those Spammers.

Digital Dave
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Facebook Buys the Oculus Rift Virtual
Reality Goggles

“For a Mere Two Billion Dollars Facebook Acquires Oculus” by Jack Dunning
Although Oculus has yet to produce a consumer product, Zuckerberg makes a heavy bet on the future of
Virtual Reality.

Since before the Facebook Initial Public Offering (IPO), CEO Mark Zuckerberg has been on a
spending spree. People are wondering whether he's a prescient visionary or just plain crazy.
Facebook seems to be paying outrageous prices for unrelated companies such as Oculus, a
virtual reality headset company, recently acquired for two billion dollars, or Ascenta, a five-

person British solar-powered drone designing
company, for a mere $20 million. People point
out that Zuckerberg is using Facebook stock
rather than cash to buy these companies which
may feel like monopoly money. Facebook can
always issue more stock. The primary people
hurt by this are the Facebook stockholders.
(Full disclosure: I own no Facebook stock, nor
do I ever intend to own Facebook stock.) The
reality will set in if and when the stock begins a
steady decline. Apparently this is all part of
Zuckerberg's Internet.org project to connect
the entire world to the Internet—which
includes flying drones over the jungles and
deserts to provide better connectivity. I'm not
exactly sure how the Oculus Rift Virtual

Reality Helmet fits in.

Oculus Virtual Reality Hardware
What makes the $2 billion price paid for Oculus unusual (at least since the Dot.Com bubble) is
that Oculus has yet to deliver a consumer product. It isn't unusual for high prices to be paid to
companies that haven't turned a profit, but normally there is compensating potential, such as
the vast number of users on YouTube when Google purchased the still unprofitable company
for $1.65 billion is 2006. Oculus may have a good product, but it hasn't been proven in the
consumer market—and there is nothing new about people building virtual reality devices, but
then most of those weren't very good.
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Figure 1. The Oculus Rift DK1 has shipped over 60,000 developer units.

After a successful launch on Kickstarter which raised almost $2.5 million, the Oculus Rift
headset has garnered rave reviews at show demonstrations. Most people who have test driven
one are very impressed. The experience is apparently unbelievably realistic.

What is Virtual Reality?
Virtual Reality (VR) reality is the digital replication of a world which interacts with all of our
human senses to the point where it actually seems real. That includes 3D views and audio for
the eyes and ears. It is explained as an experience far beyond that of watching one of the
current 3D movies with a pair of polarized glasses. To qualify as true VR total immersion is
required. There must be input for each eye which provides the 3D experience and sensors that
track head movements. Any audio must match the video. When you cock your head or turn
body, the view must smoothly adjust as you visually explore what some might call the
"holodeck"—straight out of Star Trek. At least, this is the goal. The ultimate in VR would be
strolling through an environment and interacting with avatars in a manner that makes it all very
real. The next major step in computer gaming is projected as integrating a VR world. Rather
than merely playing the game on a computer, you will be consumed by the environment.
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Figure 2. A 2D image such as this could never do justice to a 3D Virtual Reality experience where the user is
enveloped in the scene. You'd better turn around to see what's behind you!

The completeness of the VR experience is heavily dependent upon the technology. The images
must be smooth without the digital jerkiness. In the past, this inconsistency has been a major
problem. The head movements must be finely sensed feeding back any changes to the
processors which render the view. In a stationary world, a slight movement of the head must
smoothly render the scene in such a way that it's as if the scene has not moved at all. This
requires quality sensors and considerable computing power. It's only recently that CPUs have
become powerful enough to even begin to handle the massive amount of data processing
required.

The Oculus Rift
The current versions of the Oculus Rift are developer's kits. About 60,000 of the first kit have
shipped at a price of $350 each. Oculus now is taking preorders for the second kit, the Oculus
Rift DK2, which has even better performance than the earlier version. But creating the full
immersion experience is a tough nut to crack. "DK2 isn't identical to the consumer Rift, but
the fundamental building blocks for great VR are there. All the content developed using DK2
will work with the consumer Rift. And while the overall experience still needs to improve
before it's consumer-ready, we're getting closer everyday—DK2 is not the Holodeck yet, but
it's a major step in the right direction."
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Figure 3. The Oculus Rift DK2 is the latest improvement in VR headwear, although the consumer version is not
quite ready.

The Oculus Rift DK2 includes an accelerometer, gyroscope, and magnetometer for tracking
head movement and OLED displays (one for each eye) with a 100° field of view. (Normal
human field of view including peripheral vision is about 180°.) It also includes a near infrared
CMOS camera which I assume is for another type of tracking function—although details were
scant. The view is smoother than the DK1 bringing it a little closer to the goal of full-on VR.
The Oculus Rift is the state of the art in VR helmets, yet not quite ready for primetime.

The Problem with Virtual Reality
Decades ago, I tried on a virtual reality headset at the San Diego Computer Fair. The best that
I can say is that it made me nauseous. The problem is that the brain wants what it sees (the
eyes) to match up with the motion sensed by the inner ear. If it doesn't, then you get seasick.
Some people are more sensitive to this than others and eventually people can become
accustomed to the disparity. (Back when I was in the Navy, after being at sea for a long period
of time, I would eventually settle in with a decreased sensitivity to the ship's motion. I no
longer felt any ill effects from the constant rolling and pitching. However, when back on dry
land I would erroneously sense that earth was moving under my feet.) This is one of the major
reasons why virtual reality, despite decades of hit and miss attempts, has been a
disappointment on computers—"simulator sickness." There are some major investments which
seem to have paid off in the VR rides at theme parks and 3D movie theatres, although these
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are a far cry from the goals of the Oculus Rift. While there have been many previous attempts
at producing VR headwear that would capture the gaming market, none has gotten much
traction. Will the Oculus Rift be any different?

It's easy to see how the Oculus Rift might become an important part of the gaming industry.
With 60,000 developer kits shipped there is certainly a contingent of programmers building
new applications for the headgear. But it is more difficult to see exactly how it fits into the
Facebook strategic plan. Or, maybe Zuckerberg tried one out at a computer show and said,
"That's really cool! I have to have it!" In any case he ponied up two billion in stock.

People speculate that the plan is to introduce VR to Facebook allowing friends to socialize
from a distance in a virtual world. The problem with this plan is bandwidth. The Internet (with
the exception of current efforts by Google to introduce gigabit Internet) is notoriously slow.
While the VR helmet may work well when directly connected to a computer, when data must
stream over the Internet bottleneck the experience is likely to be literally revolting. Maybe in
20 years.

Early Kickstarter supporters of Oculus are not particularly happy about the Facebook deal.
Many feel betrayed and vow to never to wear their Rift again. Would they've been any
happier if Google had bought Oculus? Possibly. Google has a better reputation for nurturing
technology. Facebook looks more like a Google wannabe that uses a shotgun approach to
acquisitions. While Google has made some seemly unusual decisions, they always appear to be
crazy like a fox. Zuckerberg acts in the mode of, "I'd better do something (anything) quick
before it all goes away." Just like the younger kids who are now abandoning Facebook because
their parents showed up. Remember MySpace? Neither do I.

The Facebook $19 Billion dollar acquisition of WhatsApp seems to make more sense. At least
Facebook is getting 200 million smartphone Internet users. The Oculus deal just looks a little
off the wall. It's not like Oculus is the only company working of VR helmets. The Rift might
be the best of its kind right now, but they have not gone unnoticed. In the works is the Sony
Morpheus.
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Figure 4. The Sony Morpheus Virtual Reality Headset.

I've been watching the development of VR for decades. I certainly think that it has a future in
gaming—although I don't know when the technology will be good enough for someone to
spend the entire day shrouded in VR gear. There will also be uses in other areas such as flight
simulators for training. It is exciting technology, but is it really a big part of the future? I tend
to think that VR helmets are a niche product with limit application—but then my predictions
are usually wrong. I don't even like to wear a hat.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.
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Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Easy Beginner
AutoHotkey
Tricks You
Should Use
for Adding

Currencies, Special Symbols and Fractions
“If You Do Nothing Else, Use AutoHotkey to Add the Special Characters You Want to
Your Keyboard” by Jack Dunning

While there are other ways to add foreign currency symbols and special characters to your documents,
files, and Web edits, nothing is easier than AutoHotkey.

Every once in a while I find that there is a special symbol that I want to use, but there is no
key for it on my keyboard. There is a dollar sign, but no British Pound (£) key or Euro (€)
key. For math or casual estimates there is no key for the plus or minus, + or -, symbol (±). In
marketing, how often is the registered trademark sign (®) or copyright sign (©) needed?
Would you like to be able to add the condensed ½ to any document or Blog rather that the
three character 1/2? Just this week I was able to add the degree symbol (°) to the Oculus Rift
VR helmet article without consulting Windows Character Map (see Figure 1). (Run =>
CharMap to open.)
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Figure 1. Windows Character Map (CharMap) can add special characters to your documents.

You can add all these special characters (and any others that you need) without making any
changes to your keyboard. Use AutoHotkey's hotstrings to auto-replace short key sequences
with the special characters you need. If you do nothing else with AutoHotkey, do this.

Automatically Adding the Special Characters to
Documents and Editing Fields
The great thing about this AutoHotkey technique is that it is simple to do. All you need is a
short text file with as little as one line of code. The following is a list of some of the special
hotstrings I use. For currencies:

:*:pound*::£
:*:euro*::€
:*:yen*::¥
:*?:cent*::¢

A hotstring replacement line always contains two sets of double colons (::). The first set of
colons starts the hotstring line and may contain option code letters between the two colons
such as the * and *? seen above. The hotstring and replacement characters are separated by
the second set of double colons (::). After running the script, whenever pound* is typed, £ will
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appear; when euro* is entered, € replaces it; the ¢ sign is added to any document by typing
cent*.

For installation of the free AutoHotkey program, see "Installing AutoHotkey and Writing
Your First Script."

The purpose of the asterisk * between the first two colons is to force the hotstring to execute
immediately when the last character is hit (in this case it happens to be another asterisk *).
This eliminates the need to hit a punctuation key or spacebar to execute the replacement. The
* option is important for currencies since a number which does not activate the replacement
normally follows the symbol. The reason for the asterisk at the end of each hotstring is to
create a unique hotstring with characters that you would not normally type. This helps to
prevent the accidental addition of the special characters at unexpected times. For example,
without the asterisk as part of the pound* hotstring, you would get the £ symbol every time
you typed, "I want a pound of flour." or "I want a £ of flour." I'm not likely to type the word
"pound*" with an asterisks unless I want the £ character.

The question mark ? option between the first two colons forces the hotstring replacement to
occur even when it is in the middle or at the end of another word. This is especially important
for the cent sign ¢ since it normally will fall at the end of a number without any intervening
space. (The order of the options, :*?: or :?*:, make no difference.)

When writing the script, you can use Windows Character Map to copy the symbols and paste
them directly into the script text file.

Here are a few other special hotstrings that I use:

:*?:+-::±     ; plus or minus sign
:?*:(c)::©
:?*:(r)::®
:?*:(tm)::™
:*?:`.` `.` `.::…  ;  ellipsis

The plus or minus sign is cool because all you have to do is type the plus (+) sign then the
minus (-) sign. It instantly converts to ±.

I picked (c), (r), and (tm) because those are the keys that would be used on a typewriter for
copyright, registered trademark, and trademark.

In the last example, I use three periods with spaces between them to create the ellipsis
character (…). Since both the period and space are activating characters, I must use the
accent/backtick escape character (`) before each in the hotstring. I could have eliminated the
spaces in between, but I didn't want ellipses to start popping up each time I typed a number of
periods in a row—although I can't remember the last time I did that.

For the few fractions available and other symbols I added:
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:*:1/4*::¼
:*:1/2*::½
:*:3/4*::¾
:?*:deg*::°

Since I had previously implemented the AutoHotkey AutoCorrection script for the most
common misspelled words, it was easy to add these lines to the end of the file. That way I
didn't need to run a separate script.

Tip: If you want to prevent the activation of a hotstring, click a mouse button before you
complete typing the hotstring that activates the replacement.

If there's only one special character that you need readily available, then that's all you put into
the AutoHotkey script. You can also compile the script into an EXE file which will run on any
Windows computer. That eliminates the need to install AutoHotkey on every machine you
use.

If you want to eliminate the steps involved in finding and using certain special characters, then
this is an AutoHotkey trick that you really should use.

*                    *                    *

Find more AutoHotkey scripts at our AutoHotkey Scripts page!

*                    *                    *

The new second edition with more chapters and an index to the
AutoHotkey commands found in the book is available in e-book
format from Amazon (and other formats—EPUB and PDF— at
the ComputorEdgeBooks Web site linked below). Jack's A
Beginner's Guide to AutoHotkey, Absolutely the Best Free
Windows Utility Software Ever!: Create Power Tools for
Windows XP, Windows Vista, Windows 7 and Windows 8 offers
a gentle approach to learning AutoHotkey.

Building Power Tools for Windows XP, Windows Vista,
Windows 7 and Windows 8, AutoHotkey is the most powerful,
flexible, free Windows utility software available. Anyone can
instantly add more of the functions that they want in all of their

Windows programs, whether installed on their computer or while working on the Web.
AutoHotkey has a universality not found in any other Windows utility—free or paid.

Based upon the series of articles in ComputorEdge, Jack takes you through his learning
experience as he explores writing simple AutoHotkey scripts for adding repetitive text in any
program or on the Web, running programs with special hotkeys or gadgets, manipulating the
size and screen location of windows, making any window always-on-top, copying and moving
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files, and much more. Each chapter builds on the previous chapters.

For an EPUB (iPad, NOOK, etc.) version of A Beginner's Guide to AutoHotkey click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of A
Beginner's Guide to AutoHotkey click here!

*                    *                    *

Jack's latest AutoHotkey book which is comprised of updated,
reorganized and indexed columns from ComputorEdge is now
available at Amazon for Kindle hardware (or free software)
users. Since the columns were not all written in a linear fashion,
the book has been reorganized and broken up into parts by topic.
The book is not for the complete beginner since it builds on the
information in A Beginner's Guide to AutoHotkey. However, if a
person is reasonably computer literate, they could go directly to
this book for ideas and techniques without the first book.

For an EPUB (iPad, NOOK, etc.) version of Digging Deeper into
AutoHotkey click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of
Digging Deeper into AutoHotkey click here!

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
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What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Wally Wang's Apple Farm
“Everyone's in Sales” by Wally Wang

Everyone's in Sales; Death by PowerPoint; The Hint of Wearable Computing; Turn Off Notifications in
Safari.

Ask most people what they think of sales and they typically think of a pushy salesperson
pressuring you into buying something you don't want or need, and overcharging you in the
process. While this may be true with used car salesmen and politicians, it's not an effective
strategy any more. That's because in the old days, sales people had all the information about a
product from how much it cost to what it could do. Daniel H. Pink, the author of To Sell Is
Human, calls this information asymmetry. When one side (the sales person) knows more than
the other side (the customer), it's easy to take advantage of the less knowledgeable person.

Today, it's easy for anyone to not only investigate different products quickly and accurately
over the Internet, but to find out previous customer responses to a particular business. In the
old days if a sales person ripped you off, you could complain to your friends and family. Now
you can post a comment on Yelp, Twitter, or your own blog and get your message out to
thousands or even millions of other potential customers who can then be wary of dishonest
businesses.

With customers often knowing just as much about a product as the sales person, it's harder for
pushy sales people to take advantage of customers without others eventually learning about
one customer's poor experience. As a result, businesses have been forced to work more as
partners with customers and less as adversaries.

In To Sell Is Human, Daniel H. Pink talks about how today's businesses can no longer sell
junk to customers. Instead, they need to maintain relationships with customers. A study even
showed that paying sales people more of a base salary and less of a commission actually
increased sales. That's because sales people felt less pressured to make a sale (to make
money) and were more willing to take their time to help potential customers find a solution.

Even better, stripping away commissions let sales people help each other. In a commission-
based system, nobody has incentive to help each other since if one person makes a sale,
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anyone helping that person doesn't make any money. By minimizing commissions, companies
can encourage sales people to work together instead of fighting against each other.

When companies focus on maintaining relationships with people rather than just make one-
time sales, they tend to have more loyal customers who repeatedly buy from that company.
That's why Microsoft is hoping to move from selling licenses of Microsoft Office to selling
subscriptions to Microsoft Office. The key is that Microsoft now has to keep their customers
happy so they'll continue paying for Microsoft Office.

Apple has long recognized that they're in the relationship business. When you buy an Apple
product, you can walk into an Apple Store to get help from an actual person instead of calling
an outsourced technical support center in another country. Apple gives away their iWork office
suite to make their Macintosh computers and iOS devices more attractive. Then they continue
offering updates for free.

PC manufacturers like Dell and Hewlett-Packard often sell customers a PC and that's the end
of the transaction. They don't want you to contact them for help so they automate and
minimize the cost of that process as much as possible. Need help fixing your PC? Check Dell
or Hewlett-Packard's Web site for the right drivers, which is something a non-tech-savvy
person will have no idea what to look for. If digging through a Web site doesn't solve your
problem, call their outsourced technical support center, wait on hold, and have someone try to
turn you into a technician to troubleshoot and fix your own PC over the phone, which can be
as frustrating as trying to perform open heart surgery by taking directions over a phone.

When companies only make money selling you a product, they don't want you to contact them
ever again unless you plan to buy something else from them. Because of this incentive to keep
you away, their service tends to be poor and deliberately frustrating in hopes that you'll just go
away and stop costing the company money.

What most companies don't realize is that everyone is in sales. Even if you call a technical
support center in India, that technical support person needs to sell you on the idea that the
company is supporting you and not trying to frustrate you. An engineer who designs a PC
shouldn't just focus on cramming as many parts as possible into a beige box that sits on the
floor. Instead, the engineer needs to design a product that helps sell that product to the
customer's mind.

Many people buy a Dell PC one day and a Hewlett-Packard PC the next simply because
there's little reason to stick to any particular Windows PC manufacturer. What's the difference
between a Hewlett-Packard PC and a Dell PC? Not much, which means customers typically
choose one or the other based on chance.

On the other hand, there's a huge difference between a Macintosh and a Dell PC. Macintosh
computers are designed to look good and be functional while most beige box PCs are designed
simply to be functional. When customers like the aesthetic appearance of a product, they'll be
more likely to buy another one later. When customers don't like the aesthetic appearance of a
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product, they'll likely buy something else.

So when critics complain that Apple simply makes pretty products, they're right, but they're
missing the point. Pretty products help sell them while ugly products help drive potential
customers away. If making pretty products helps increase repeat sales, then it's not just about
being pretty but about keeping and attracting customers. When critics dismiss the aesthetic
appearance of Apple products, they're basically saying that they don't understand how to keep
and attract customers other than overwhelming them with technical specifications that most
people don't understand or enticing them with low prices that practically eliminate profits so
companies can't provide a decent level of support.

Pretty products help sell them. Creating products that are simple and don't overwhelm users
also help sell them. Providing actual service is still another way to sell products. When you
only try to sell products by lowering prices, cramming technical specifications in a product, or
relying on pushy sales people, you're not reaching potential customers in a million other ways
that can be more effective.

Not only is every person a potential sales person for a company, but every aspect of a product
is a potential sales advantage (or disadvantage) to promoting a product. Make a product hard
to use and ugly to look at, and you're not likely to entice potential customers. Ignore customer
service before and after the sale and you'll definitely drive away more customers.

There's a reason why so many companies try to mimic Apple, but they should really be trying
to mimic the idea of making products that sell themselves. Just doing that alone would be more
profitable and less expensive than wasting money on million dollar advertising and celebrity
endorsements. Then again, most companies still think that they need to fool, trick, and deceive
people into buying their products like the pushy sales people of the old days.

There's a reason why you don't see door to door salesmen any more. Because being
obnoxious, pushy, and deceitful doesn't work any more. There's also a reason why you see so
many companies trying to mimic Apple because they realize that their old way of doing
business isn't working any more either. The difference is that they think mimicking Apple is
the secret when the real secret is simply helping customers solve problems and keeping
customers happy.

That's no secret at all, but it will take another few decades for some companies to figure this
out while they shovel millions at ineffective CEOs and can't figure out why sales keep tanking
every year.

Death by PowerPoint
Search for "Death by PowerPoint" and you'll find all sorts of references to how people use
PowerPoint incorrectly to bore people to death. Often times people cram too much
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information in a PowerPoint slide or simply read the text on the slide, which audiences can do
faster. That's why there's a new movement called PechaKucha.

The idea behind PechaKucha is to limit a PowerPoint presentation to exactly 20 slides that
appear on the screen for exactly 20 seconds. This forces a presenter to be precise and
informative. By imposing these artificial limits on people, PechaKucha encourages people to be
more creative with their PowerPoint presentations. The next time you need to make a
presentation with PowerPoint or Keynote, take a quick peek at the PechaKucha examples. By
following these examples, you can see that more slides and information doesn't always equal
greater comprehension. If more people took the time to learn how to communicate more
effectively, the phrase "Death by PowerPoint" would no longer seem so relevant.

If you're interested in learning how to communicate more effectively, you can start by
focusing on facts (which far too many people find difficult to do). Then find a way to describe
those facts in either words or graphics. Since visuals can improve comprehension, you might
want to convert raw data into pictures.

However, too many people create confusing, cluttered, and pointless graphics. To learn how to
create informative graphics, read The Functional Art by Alberto Cairo. Alberto emphasizes
that graphics need to do more than be pretty. Instead, they need to:

• Communicate information
• Help readers understand that information
• Allow readers to analyze that information and reach conclusions

Raw data in a table form simply confuses most people since they can't see relationships
between data or compare different sets of data easily. If you convert those numbers into
pictures, notice how much simpler understanding and comparing information suddenly
becomes.
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Figure 1. Infographics not only look good but provide useful information.

By learning how to create visuals that entertain and inform, you can become a better
communicator. Rather than bombarding people with raw data, you need to learn different
ways to present information so it's easy for people to understand and reach conclusions.

Visual communication extends beyond making presentations but also to user interfaces. The
brain tends to excel at recognizing patterns and differences such as size, orientation, and color
differences. When a user interface displays two buttons but one is bigger than the other, that
size difference makes the bigger button stand out as either more important or more likely to be
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used.

Figure 2. The Firefox browser makes the Back button larger since it's typically used more often than the Forward
button.

Good user interfaces also organize items by proximity, similarity and connectedness.
Commands grouped together (such as in the File menu) helps you understand the purpose of
other commands in that same group, even if you aren't sure what they might do. If you aren't
familiar with the Close command, just knowing that it appears in the File menu hints that the
Close command does something to an entire file rather than to individual data in your
document.

Dialog boxes tend to work in similar ways by giving you multiple options to choose from.
When you click on the File menu and see a Print dialog box, this connection helps you realize
that you need to use the Print dialog box any time you want to print anything.

Communication is always about saying as much as possible with as little as possible. By
reading "The Functional Art" or visiting its supporting Web site, you can learn the principles of
good graphic communication design so you don't bore your audience through another "Death
by PowerPoint" presentation.

If you're a programmer, studying "The Functional Art" can also help you design more effective
user interfaces that simplify tasks for the user rather than hide commands out of sight and
force the user to play guessing games to find anything, which is what the Windows 8 tile
interface does. Is it any wonder why so many people dislike the Windows 8 tile interface when
it makes simple tasks different while providing no benefit in return other than letting you touch
the screen?

The Hint of Wearable Computing
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If you're interested in running and tracking your progress, you can wait for Apple's rumored
iWatch device, or you can get a hint at the possibilities of wearable computing if you download
and install RunKeeper on your iPhone. RunKeeper uses your iPhone's GPS capability to track
where you ran and how close you may be to any goals you may have defined earlier such as
running a certain distance each day.

To use RunKeeper, you'll need to carry an iPhone around in your pocket. If Apple's iWatch
arrives soon, you should be able to track your running progress with a wearable computer
instead. While some people might carry their iPhone with them anyway just in case they need
to make a call, others might prefer a smaller device for the lower weight and smaller size.

Figure 3. RunKeeper can track how far you've run and where you went.

Now imagine professional athletes strapping wearable computers on their wrists, waists, or legs
to track their movements, especially in situations where carrying an iPhone will be impractical,
such as in the middle of an actual sporting event. A wearable computer could provide
interesting data showing how far someone might have run. If a particular athlete's effectiveness
tends to fade after running a specific distance, the coach could take the player out.
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Wearable computers will likely spark the imagination of others who will find creative uses for
wearable computers. While unimaginative critics will always cling to obsolete beliefs about
computers that can be easily refuted, everyone else will find ways to benefit from wearable
computers in ways limited only by their creativity. That means wearable computers have an
unlimited number of possible uses that will make wearable computers as disruptive as tablet
computers compared to ordinary PCs.

For another interesting use of mobile computing that could also apply to wearable computing,
you can read about an app called A-CHESS designed for alcoholics. With this app installed on
your smartphone, the moment you get too close to a bar, the app alerts you to move further
away.

If the app alerts you too many times, the phone will ring with a recorded message from a
friend or family member urging you to stay sober. If you need immediate help, you can press a
panic button to contact your sponsor or someone else who can help. The app also has
relaxation exercises and games to distract you from thinking about alcohol.

Imagine strapping a wearable computer on an alcoholic that could perform similar functions,
especially if you fix the wearable computer so it can't be removed or if it sends an alert to a
friend if you try to remove it. Wearable computers have plenty of possibilities for helping
people in ways that ordinary PCs could never do and they don't need a physical keyboard to
be useful either.

The future of wearable computing is coming. The only question is how will you find a way to
benefit from this new technology?

*                    *                    *

If you visit many Web sites, they may ask for your permission to notify you of news.
Sometimes you may want this, but many times you may not. To see a list of Web sites that
have requested to notify you, click the Safari menu and choose Preferences.

Click the Notifications icon. Now you can selectively choose to Allow or Deny which Web
sites can send you notifications. If you want, click the Remove or Remove All button to
remove one or more Web sites from your list altogether.
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Figure 4. You can turn off notifications in Safari.

In the early days, before Wally became an Internationally renowned comedian, computer
book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer
dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2013 For Dummies

Beginning Programming for Dummies

Beginning Programming All-in-One Reference for Dummies

Breaking Into Acting for Dummies with Larry Garrison

Strategic Entrepreneurism with Jon and Gerald Fisher

How to Live with a Cat (When You Really Don't Want To)

The Secrets of the Wall Street Stock Traders
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Mac Programming For Absolute Beginners

Republican Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

The Zen of Effortless Selling with Moe Abdou

The 15-Minute Movie Method

Erotophobia (A novel)

Math for the Zombie Apocalypse

How to Write a Great Script with Final Draft 9

How to Write a Great Script with Fade In

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15
Minute Movie Method," finding interesting news stories about cats at his site "Cat Daily
News," giving advice to authors who want to self-publish e-books at his site "The Electronic
Author," and providing the type of advice he wishes someone would have told him when he
was much younger at his personal Web site. Wally can be reached at
wally@computoredge.com or you can follow him on Twitter @wallacewang_com.
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Without Digital
Music, Life Would Be
an Error
“or, On the Evolution of Online Music
Distribution” by Matthew W. Beale
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RIAA Issues Apology, Cash Settlements; The Rite of Bieber

Billy Idol Rides a Pony Pony, Announcing New
Project This Past Tuesday

Not to be outdone by Neil Young's recent keynote SXSW
address concerning his high-end Pono digital music project, Billy
Idol recently announced a project of his own: Pony-Pony.

In obvious mock reference to Young, and playing off the title of
one of his own biggest hits, Pony-Pony was announced this past
Tuesday at the annual Be Your Own Idol fan fest, and is self-
described as "an 8-track for the 21st century."

The project wants to bring "the raw quality and grittiness of 8-
track tapes back to the masses," first through a reengineered version of the seemingly
antiquated technology, and then through "digitized versions of the music from there,"
according to a press release. "Low-Fi is the essence of the zeitgeist in photography at the
moment, and with all the fervent interest in vinyl, we wanted to keep bringing that to music,
pushing it to its logical conclusion."

"We're going to fill a hole in music," said Idol, without elaborating, in a Twitter post.

More formally known as Stereo 8, it gained very little traction in Europe, and as record
companies sought to reduce the number of formats utilized for its release schedule, the 8-track
tape largely fell out of popular use by the early 1980s.

But the Pony-Pony Project sees the format's "weaknesses as its very strengths." "Am I the
only one that thinks high wow and flutter are cool things?" asked Idol of a largely confused
interviewer from a Reno radio station. Idol was promoting a forthcoming live album release,
"When Albatrosses Attack Albatrosses," presumably a contrived title.
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Bob Windybottom, chief music and new media analyst for the Windybottom Analysis Group
(their motto is, "we sniff out the future for you"), asked "who wouldn't prefer a photocopy of
the freaking Mona Lisa? Seriously, no fans of dAdA out there?"

The Pony-Pony Project will be launching on Indiehoho—Indiegogo for dubious, unapproved
projects—sometime in 2015, with vague promises of "magic," although many seem to be little
more than pre-launch pranks and are of a highly inappropriate and illicit nature.

"Nostalgia never was what it could be, so get off your...and with a rebel yell, pledge more,
more, more," said Idol via the Psychics Rock Network PR firm.

A complete absence of project details, specifically (and very
significantly) the tech itself, didn't stop the 8-Track Tape
enthusiast community—who have, for instance, published zines
on the subject of their obsession for years—from showing some
interest and enthusiasm.

"It sounds to me like Billy is just having a laugh," said James
Burnett who runs The 8-Track Tape Museum in Dallas. "But if
he is serious, I wish him all the best."

"Ride your pony, ride your pony, Ride your pony come on, come
on," said Whip Lash Smile, who runs a Billy Idol fan site, in a
late night message left on this reporter's voicemail, quoting the
famous single. "Mony Mony, feel all right, I said yeah, yeah, yeah, yeah, yeah. You know
what must be done."

Juan de Jamón, Pony-Pony spokesman, stated—in a brief interview via zen-like Tweets—that
"everyone knows that magic doesn't exist, unless you're talking about music," adding, rather
cryptically, "tag, you're it!"

The Blair Witch is Back!
Just when theatres seemed safe from The Blair Witch (although
like reality TV, it may sadly never really leave, courtesy, for
instance, myriad dreadfully derivative, so-called horror flicks),
she's back. Marilyn Manson, after taking the helm of the
soundtrack for the critically-acclaimed sequel, Book of Shadows:
Blair Witch 2, is being given complete artistic control over the
next installment of the franchise, reportedly a prequel.

Manson is set to not only direct the project, but produce, star in, and yes, create the
soundtrack, too. The tentative title is Blair Witch Beginnings: a Delirious, Visionary, and
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Mysterious Mansinthe Nightmare (a project thought by many industry insiders to be little more
than a 2-hour infomercial for the rock star's brand of Absinthe).

"Everyone who attends a screening will receive complimentary Mansinthe, plus they'll also get
a copy of both the movie and the soundtrack as they exit courtesy Google Inject (™)," said
Manson. "The files are to be delivered, with a Chrome-based GUI, by a small needle inserted
into the brainstem, and then this experience can be available for you anytime and forever!"

"Dr. Benway, the Medical Supervisor for the project, will personally supervise administration
at the first screenings in Hollywood," said a press release. "Medical personnel under contract
from the project, and trained by Benway, will be available at all other showings."

RIAA Issues Apology, Cash Settlements
In a surprise move, the RIAA on Tuesday apologized "to the world,
or certainly anyone who listens to music," and promised checks to
back it up, according to a statement issued by the organization
offline via its recently launched, "cutting edge" String and Can
Publicity Services Network. "We apologize for our dumb ...
behavior, and would like to formally invite music fans of the world
to forgive us."

The move comes as a surprise to Bipeds everywhere, although a
statement issued by the Society for a World Dominated by Ferociously Feral Felines strongly
protested the first part of this sentence.

Guy Montag, former fireman and President of RIF (Reading Is Fundamental), who is the
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current unofficial Guru for the RIAA, asked consumers in a prepared statement to "add up
every song you've ever heard, regardless of the medium with which they were encountered -
CD, MP3, Spoofify, your partner singing in the shower, whatever—multiply that by -$3.23,
and submit the number, no matter how ridiculous it may seem, to: RIAA, NY, NY. Trust me,
we'll be in touch!"

Montag was not immediately available to comment on this story, but
Frank, a one-eyed, middle-aged man who wears a bunny outfit and
stalks the (imaginary) ComputorEdge office in El Paso, Texas, flatly
stated: "you can print the … thing, roll it up and stick it ... and that
will make it all more accurate, newsworthy, and, frankly, better. Did
you see what I did there?! I said Frankly. Whoo!" [Editor's note: even
though he apparently cannot seem to locate us, and we're uncertain if
he's actually literate, or whether or not he lives FT in this dimension,
we fear for our lives should we choose not to print his occasional rantings. We appreciate your
understanding, and possibly even your help.]

The Rite of Bieber
Justin Bieber, who gave the world the gift of his
announced retirement last Christmas, is evidently back.
Bieber and "three drunk guys from Venice Beach,"
presumably members of his entourage, have recorded a
"Bieber Shop Quartet" rendition of Stravinsky's Le Sacre
du Printemps. When reached for comment, Stravinsky
Zombie retrieved a violin, played something from Histoire
du soldat, according to witnesses, and proceeded to eat the

reporter. I'll be reviewing the digital release in an upcoming column, unless of course a PHA
(Potentially Hazardous Asteroid) smashes into us first, bringing about an end to the world as
we know it (in which case, I'll feel fine fine fine fine fine fine fine... yeah). Thank you. Please
don't litter.
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My first published work focused on music, and related obsessions pushed me to become a
DJ, Producer, and Music Director in college radio. With this column, I feel as though I'm
sort of returning to something I love (although I've never left, really). I've been tracking the
evolution of online music distribution since the days of Napster, and obsessively follow
music releases across a range of genres. One of my music players (on each of my devices) is
going from the time I wake up until the end of the day, lulling me to sleep (or what little I
actually grab). "Without music, life would be an error." ~ Fred, the mad German

Significantly, I'm returning to work after a prolonged personal leave, functioning in the
capacity as a caregiver. Please feel free to contact me with story ideas or suggestions about
digital music releases at withoutmusiclifewouldbeanerror@hushmail.com.

April 4, 2014 The Rite of Bieber

41

mailto:@?subject=withoutmusiclifewouldbeanerror@hushmail.com


Editor's Letters: Tips and
Thoughts from Readers
“Computer and Internet tips, plus comments on the

articles and columns.” by ComputorEdge Staff
"Windows 8.1," "Margaret's Computer"

Windows 8.1
[Regarding Jack Dunning's March 14 article, "Windows 8.1 Update 1 Is for PC Users":]

Paul Thurrott has updated info about Windows with Bing. Apparently, it's a lower price for
OEMs only so they can put it on cheaper Windows computers (under $250).

-Ron Cerrato, San Diego, CA

Hello Jack,

I recently bought a new laptop that came with Windows 8.1. I should have spent the money
on the $400 repair estimate on my not-so-old HP with Windows 7.

8.1 is as close as possible to being the only thing in the world that is worse than Windows
Vista.

What a pathetic excuse for an operating system. I can't log off Hotmail to log in to my other
HM account. I can't get my computer back up after going through the (three step sequence,
not Windows 7's two step sequence) power down process. I have to shut it down with the
power button now. Video from the NASCAR Web site freezes for a second or two then skips
forward and freezes again. (The audio is continuous.) If I leave it for a while, it goes to sleep
and I have to power it down (with the power button of course) and then power it back up.

This beast is about as intuitive as COBOL.

Thanks, Microsoft!

(Thanks for letting me vent.)

Hi, Wes,

It sounds like you're having more problems than I am. I certainly sympathize.
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I don't know if you're doing this but if you right-click on the fake Start button on the
Taskbar, then you have direct access to the Shut Down options. Plus the same menu has
Power Options where you can prevent your computer from going to sleep. I never let my
Windows computers go to sleep regardless of version. It always seems to have issues.

I'm guessing that you could use the same Shut Down menu to Sign Off, then log in again
with another account, but you need to create the account first (Account Settings—Add,
delete, manage, WIN+W, then search for accounts) with the alternate e-mail address. But if
all you want to do is get your e-mail, then with any of the e-mail programs you should be
able to add an account for each address.

Plus I don't know which browser you're using for then NASCAR videos, but I might try
Chrome or Firefox, if you're not already doing that.

I agree that Windows 8.1 is not particularly intuitive. I'm hoping that the upgrade coming
out next month will be an improvement.

Thanks,

-Jack

-Wes Nelson

Margaret's Computer
[Regarding the March 14 Digital Dave column:]

Hi Margaret,

Assuming your HP is running XP and it is under 20 years old you can probably pick up a
refurbished computer for under $200 on eBay or Amazon that will be almost exactly like your
current Laptop, (faster, more memory and bigger hard drive is possible with careful shopping).
I entered the following search into a Google search window and chose the eBay result (second
choice, had 25 possible PCs, Amazon—the next choice- 65 possible, most under $200). Here
is the search I used, "HP laptop refurb win xp core 2 duo."

I'm 65 and don't mind trying something new, but I have a laptop that is just like the first one I
ever had and it is my "Go To" PC for most of my Internet tasks. It only cost me $185 and is
running Vista. Knowing that MS is going to cut support of Win XP soon would prompt me to
go for at least Vista, but as Dave said Win 7 is not that much different from XP and if you had
a computer similar to your current one then the change would be easier to take.
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Yours,

-Buck-O, El Cajon, CA

Hi Mugs,

In as much as we have been best of friends for many years now, I caught your question for
Dave. Next time you visit me, grab a copy of Jack's "Starting with Win 7" (or we can pick up
one at Barnes & Noble) and spend some time with my laptop which has Win 7. As you know,
while we are kicking around ages, I am working on 94 this year and have been reading Dave
for a long-long time. See you soon.

-Carl, Encinitas, Ca.

Excellent advice from Dave & Buck-O. But I was thinking that if Margaret's present computer
works for you and the only problem is a virus slowing it down, why not just reformat the hard
drive and reinstall XP and the programs you use. Be sure to copy your document files to an
external device like a USB drive or DVDs first. In any case you could try this while you are
looking for a replacement computer. I still use a Windows 2000 computer so I think the fuss
about Microsoft dropping support for XP is a joke.

-Dennis, San Diego

ComputorEdge always wants to hear from you, our readers. If you have specific comments
about one of our articles, please click the "Tell us what you think about this article!" link at
the top or bottom of the specific article/column at ComputorEdge.com. Your comments will
be attached to the column and may appear at a later time in the "Editor's Letters" section.If
you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at
ceeditor@computoredge.com. If you would like to review our recent e-books, please visit
ComputorEdge E-Books.

Send e-mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.
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